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El portal en la nube ofrece acceso a informes de pruebas 
digitales y permite gestionar técnicos, dispositivos y 
suscripciones activas desde un panel de control centralizado.

Si	va	a	configurar	su	cuenta	por	primera	vez,	siga	estos	tres	
pasos principales: 

1. Cree	su	cuenta	de	empresa	(consulte	la	sección	1)
2. Añada	un	dispositivo	nuevo	(consulte	la	sección	2.2)
3. Invite	a	los	técnicos	(consulte	la	sección	3)

Visite nuestro canal de YouTube para conocer todos los 
detalles sobre el uso del portal en la nube y XTR2.

Para registrar una cuenta de empresa nueva, visite la página del 
portal en la nube y siga estos pasos (Fig. 1-3):

1. Haga clic en «Create Account» (Crear cuenta) para 
empezar el proceso de registro.

2. Introduzca	su	nombre,	correo	electrónico	y	contraseña,	y,	a	
continuación,	haga	clic	en	«Next»	(Siguiente).

3. Introduzca	los	detalles	de	su	empresa	y	haga	clic	en	
«Create Account» (Crear cuenta).

PORTAL EN LA NUBE DE DT CONNECT: 
CÓMO EMPEZAR

1.1 Registro de una cuenta de empresa nueva

1

Escanee	el	código	QR	que	verá	a	
continuación	o	haga	clic	en	el	enlace	
para acceder al portal en la nube: 
https://detectortesters-connect.com

Figura 1

Figura 2

Figura 3

NOTA: 
Si	ya	ha	registrado	una	cuenta	con	esta	dirección	
de	correo	electrónico	y	la	ha	olvidado,	haga	clic	en	
«Forgot Password» (He olvidado mi contraseña) para 
restablecerla.
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Figura 4

Con	su	cuenta	ya	creada,	se	enviará	un	correo	electrónico	
de	verificación	a	la	dirección	de	correo	electrónico	que	
proporcionó	durante	el	proceso	de	registro	(Fig.	4).

Haga	clic	en	el	enlace	del	correo	electrónico	para	verificar	sus	
cuentas	antes	de	iniciar	sesión	en	el	portal	en	la	nube.

1.2	Verificación	de	su	cuenta	nueva
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En	la	barra	de	navegación	superior,	haga	clic	en	la	pestaña	«Devices»	(Dispositivos)	para	acceder	al	panel	de	control	de	dispositivos	
(Fig.	5).	Aquí,	verá	una	relación	de	los	dispositivos	registrados	con	su	empresa	y	el	estado	en	el	que	se	encuentran.

Desde esta ventana podrá realizar lo siguiente:

• Añadir un dispositivo nuevo
• Suscribir un dispositivo
• Gestionar suscripciones

GESTIÓN DE DISPOSITIVOS

2.1 Gestión de dispositivos

2

Figura 5

NOTA: 
Pase	el	cursor	sobre	el	icono	(i)	junto	al	número	de	serie	
para ver los niveles de los consumibles del dispositivo 
(batería,	cartucho	y	generador).
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Haga clic en «Add a New Device» (Añadir un dispositivo nuevo) 
para registrar su dispositivo (Fig. 6).

Introduzca	el	número	de	serie	del	dispositivo,	que	encontrará	
dentro de la carcasa, y complete el proceso de registro.

Cuando el dispositivo se registre, verá la pestaña «Devices» 
(Dispositivos) y los usuarios registrados con la cuenta de la 
empresa	podrán	utilizarlo	en	la	aplicación	DT	Connect.

Los dispositivos tienen un periodo de prueba gratuito de 90 
días	de	la	suscripción	Premium	disponible	para	uso	inmediato.

Durante	el	periodo	de	prueba	Premium	de	90	días	o	una	vez	
transcurrido este periodo puede decidir si desea suscribir 
su dispositivo para conservar pleno acceso a las funciones 
Premium.	Para	suscribirse,	haga	clic	en	el	botón	«Subscribe»	
(Suscribirse)	junto	al	dispositivo	que	le	interese	(Fig.	5).

Complete	la	compra	introduciendo	los	datos	de	la	tarjeta	que	
prefiera	como	método	de	pago	(Fig.	7).

Para	cancelar	la	suscripción	de	un	dispositivo,	haga	clic	en	
«Manage Subscriptions» (Gestionar suscripciones) y siga las 
instrucciones	que	verá	aparecer	en	la	pantalla	(Fig.	5).	

Al	eliminar	un	dispositivo,	dejará	de	estar	registrado	en	la	cuenta	
de la empresa. Si el dispositivo se elimina durante el periodo de 
prueba	de	90	días,	los	días	restantes	hasta	el	fin	del	periodo	de	
prueba se cancelarán. 

DT Connect ahora se integra con las principales aplicaciones de 
terceros	del	sector	de	la	protección	contra	incendios,	por	lo	que	
podrá obtener y sincronizar los resultados de sus pruebas con 
XTR2 en sus plataformas.

Para permitir la compatibilidad:

• Al añadir un dispositivo nuevo, seleccione los permisos 
deseados para permitir el acceso a aplicaciones de terceros 
(Fig. 6).

• Si su dispositivo ya está registrado, haga clic en «View» 
(Ver)	junto	a	este	para	consultar	y	ajustar	los	parámetros	
de «Third-Party App Compatibility» (Compatibilidad con 
aplicaciones de terceros).

2.2.1 Añadir un dispositivo nuevo 2.3 Suscribir un dispositivo

2.4 Cancelar una suscripción

2.5 Eliminar un dispositivo

2.2.2 Compatibilidad con aplicaciones de    
            terceros

Figura 6

Figura 7

NOTA: 
Para	que	los	dispositivos	se	puedan	registrar	en	una	
cuenta de empresa nueva, antes deberán eliminarse.

NOTA: 
Recibirá	el	periodo	de	prueba	gratuito	de	90	días	si	la	
compra	de	la	suscripción	del	dispositivo	se	realiza	antes	
de	que	finalicen	los	días	de	prueba.

Para	comprar	una	suscripción	para	el	dispositivo,	antes	
deberá	verificarse	su	cuenta	de	empresa.	Este	proceso	
puede	tardar	entre	24	y	48	horas,	y	se	confirmará	cuando	
vea	un	icono	de	marca	de	verificación	junto	al	logotipo	de	
Detectortesters	en	la	esquina	superior	izquierda.

IMPORTANTE: 
Los dispositivos deben registrarse en el portal en la nube 
antes	de	poder	usarse	en	la	aplicación	DT	Connect.
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COMPARATIVA DE LAS FUNCIONES 
GRATUITAS Y PREMIUM
3.1 Comparativa De Las Funciones Gratuitas Y Premium

3

La	siguiente	es	una	comparativa	de	las	características	de	la	aplicación,	para	los	dispositivos	con	suscripciones	gratis	y	Premium.

La	suscripción	gratis	del	dispositivo	permite	al	usuario	capturar	los	resultados	de	las	pruebas	realizadas	con	el	XTR2	en	formato	
digital para elaborar registros internos de las tareas completadas.

La	suscripción	de	dispositivo	Premium	ofrece	a	las	empresas	toda	una	serie	de	funciones	para	que	los	ingenieros	puedan	capturar	
las pruebas realizadas en el sitio, crear una lista de activos del sitio y compartir con el cliente un informe en PDF con evidencias de 
las	pruebas.	Todos	los	registros	se	guardan	en	el	portal	en	la	nube	para	admitir	la	repetibilidad	de	las	pruebas	a	fin	de	mejorar	el	
servicio	y	lograr	una	eficiencia	sostenible.

Para	actualizar	su	dispositivo	a	la	suscripción	Premium,	inicie	sesión	en	el	portal	en	la	nube (consulte la Sección -- de la Guía del 
usuario del portal en la nube).

NOTA: 
Las funciones de las tareas en curso permanecerán 
sin cambios si durante la tarea se realiza o anula la 
suscripción	del	dispositivo.	

Los cambios surtirán efecto cuando se cree una tarea 
nueva.

Función

Prueba de sitio nuevo Creación	de	una	tarea	para	un	sitio	nuevo	

Recopilación	de	resultados	de	las	pruebas	de	XTR2	en	la	aplicación

Capacidad	para	configurar	XTR2	en	la	aplicación	(p.	ej.,	Modo	de	
prueba)

Creación	de	una	tarea	para	un	sitio	anteriormente	visitado	y	
guardado 

Lista de activos almacenada y mantenida en el portal en la nube

Capacidad	para	especificar	los	detalles	de	la	ubicación	para	crear	
un activo 

Filtro de activos por tipo, zona y bucle 

Cotejo	de	resultados	de	las	pruebas	con	el	registro	de	eventos	del	
panel de incendios 

Captura	de	una	firma	del	cliente	para	su	informe	

Genere un informe en PDF de la tarea como evidencia de las 
pruebas

Transfiera	fácilmente	listas	de	activos	con	nuestra	plantilla	en	CSV	

Compartir	un	PDF	con	el	cliente	a	través	del	correo	electrónico	

Captura de resultados de las 
pruebas de XTR2

Configuración de hardware

Prueba de sitio existente

Lista de activos del sitio

Creación de activos

Filtro del recorrido por la 
planta

Reconciliación del panel

Captura de firma del cliente

Generación de informe en 
PDF

Carga de activos en CSV

Compartir informe en PDF

Descripción PremiumGratis
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GESTIÓN DE TÉCNICOS

4.1 Gestión de técnicos

4

La pestaña «Technicians» (Técnicos) incluye un resumen de usuarios registrados en su empresa, con sus nombres y permisos de 
acceso de administrador (Fig. 8).

Los	técnicos	deben	registrarse	con	una	empresa	para	poder	conectar	y	usar	los	dispositivos	de	la	empresa	en	la	aplicación	DT	
Connect.

Cómo	añadir	a	un	técnico:	Haga	clic	en	«Add	New	User»	(Añadir	a	un	nuevo	usuario)	e	introduzca	el	nombre	y	la	dirección	de	correo	
electrónico	del	usuario	(Fig.	8).	Los	usuarios	recibirán	una	invitación	por	correo	electrónico	para	registrar	sus	cuentas.	Este	enlace	
solo será válido durante 24 horas.

Cómo	editar	los	detalles	del	usuario:	haga	clic	en	el	icono	de	lápiz	a	la	derecha	de	la	fila	de	usuarios.

Cómo	eliminar	a	un	usuario:	haga	clic	en	el	icono	de	papelera	a	la	derecha	de	la	fila	de	usuarios.

IMPORTANTE: 
El	acceso	de	administrador	otorga	a	los	usuarios	permiso	para	iniciar	sesión	en	el	portal	web	con	las	credenciales	de	su	
cuenta y gestionar informes, usuarios y dispositivos. 

Los	usuarios	sin	acceso	de	administrador	solo	podrán	iniciar	sesión	en	la	aplicación	móvil	DT	Connect.

Figura 8
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SITIOS

5.1 Descripción de sitios

5

La	pestaña	«Sites»	(Sitios)	incluye	una	relación	de	los	sitios	creados	mediante	la	finalización	de	tareas	en	la	aplicación	DT	Connect	o	
añadidos manualmente en el portal web.
Los	sitios	se	pueden	filtrar	por	cliente	y	por	fecha	de	última	visita,	o	bien	buscarse	desde	la	barra	de	búsqueda.

Cómo	añadir	un	sitio	nuevo:	haga	clic	en	«New	Site»	(Nuevo	sitio)	para	introducir	el	nombre	del	cliente	y	los	detalles	de	la	dirección	
para el sitio nuevo.

Cómo	editar	detalles	del	sitio:	haga	clic	en	el	icono	de	lápiz	a	la	derecha	de	la	fila	de	sitios	para	editar	los	detalles.

Cómo	ver	el	sitio:	haga	clic	en	el	botón	«View»	(Ver)	(Fig.	9)	para	abrir	la	página	«Site»	(Sitio).

Figura 9

NOTA: 
Los	sitios	archivados	aparecerán	atenuados	al	final	de	la	
lista.
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5.2.1 Página Sites (Sitios)

La	página	«Sites»	(Sitios)	incluye	toda	la	información	necesaria	para	realizar	tareas	de	servicio	y	mantenimiento	para	un	sitio	
concreto.
En	la	sección	superior	puede	ver	los	detalles	del	sitio,	un	mapa,	la	fecha	del	último	informe	y	el	recuento	de	activos	totales.

Archive	Site	(Archivar	sitio):	haga	clic	en	este	botón	para	archivar	un	sitio	inactivo.	El	sitio	se	ocultará	en	la	aplicación	DT	Connect,	
lo	que	evitará	que	los	técnicos	puedan	completar	tareas	allí.

Edit	Details	(Editar	detalles):	haga	clic	en	esta	opción	para	editar	detalles	del	cliente	y	la	dirección.

Debajo,	en	la	pestaña	«Job	Reports»	(Informes	de	la	tarea)	puede	consultar	un	registro	histórico	de	todas	las	tareas	completadas.	
Haga clic en «View» (Ver) para ir a un informe. 

Transfer	Assets	(Transferir	activos):	utilice	esta	opción	para	mover	activos	de	un	informe	antiguo	a	la	lista	de	recursos	del	sitio.

Figura 10

NOTA: 
Una vez archivados, ya no podrá completar informes, 
añadir activos ni editar detalles del sitio.

Los sitios archivados se pueden restaurar si los usuarios 
tienen	que	reanudar	las	pruebas.
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5.2.2 Transferencia de activos

Los	informes	completados	antes	de	actualizar	los	sitios	incluirán	la	opción	«Transfer	Assets»	(Transferir	activos).	Esta	función	
permite a los usuarios transferir activos registrados desde el informe a la lista de activos del sitio, para poder realizar pruebas 
posteriores.

Haga clic en «Transfer Assets» (Transferir activos) para abrir una ventana emergente.

Para transferir correctamente los activos, deben estar vinculados a un activo de panel de incendios.

Elija	una	de	las	siguientes	opciones:

1. Seleccione un panel de sitio existente en «Site Asset List» (Lista de activos del sitio).
2. Cree	un	activo	de	panel	de	incendios	seleccionando	el	tipo	de	panel	e	introduciendo	una	ubicación.

Tras	seleccionar	una	opción	válida,	haga	clic	en	«Transfer	Assets»	(Transferir	activos)	para	completar	el	proceso

IMPORTANTE: 
Asegúrese	de	que	los	activos	se	transfieren	al	mismo	tipo	
de	panel	que	el	del	informe	original	para	evitar	problemas	
durante pruebas posteriores.

Figura 11
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LISTA DE ACTIVOS DEL SITIO

6.1 Lista de activos del sitio

6

La pestaña «Site Asset List» (Lista de activos del sitio) es un registro permanente de activos registrados en el sitio y mantenidos en 
la nube.

Mediante	la	creación	de	una	lista	completa	de	activos,	los	técnicos	pueden	personarse	en	el	sitio,	ver	los	activos	anteriormente	
probados	y	seleccionar	aquellos	en	los	que	se	repetirán	las	pruebas,	con	la	consiguiente	reducción	de	la	duración	y	mejora	de	la	
integridad de las pruebas.

Cada	fila	de	activos	muestra	información	clave,	como	ID	(Identificadores),	Asset	Type	(Tipo	de	activo),	Location	(Ubicación),	Zone	
(Zona),	Loop	(Bucle),	Address	(Dirección)	y	Last	Tested	Date	(Última	fecha	de	la	prueba).

Haga	clic	en	«Edit»	(Editar)	para	modificar	los	detalles	de	los	activos	o	en	el	icono	de	papelera	para	eliminar	un	activo.

Cómo	cargar	activos:	utilice	la	plantilla	en	CSV	para	cargar	activos	en	masa.

Cómo	crear	activos:	Introduzca	los	activos	uno	a	uno	en	el	portal	web	para	optimizar	los	flujos	de	trabajo	del	técnico.

Figura 12
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6.2 Eliminación de activos

Para	eliminar	un	activo,	haga	clic	en	el	icono	de	papelera	a	la	derecha	de	la	fila	de	activos.	Aparecerá	una	ventana	con	un	mensaje	de	
confirmación.

Haga	clic	en	«Yes,	Delete»	(Sí,	eliminar)	para	eliminar	el	activo	de	la	lista	de	activos	del	sitio.

Al	eliminar	un	activo	de	panel,	también	se	eliminarán	todos	los	activos	conectados.	Perderá	los	datos	de	pruebas	históricos	
asociados a estos activos.

ADVERTENCIA: 
La	eliminación	de	activos	no	se	puede	deshacer.

Figura 13
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6.3 Creación de activos

Haga clic en «Create Assest» (Crear activos) para abrir una página nueva, donde podrá introducir uno a uno detalles de los activos 
en los campos de entradas al efecto.
Tras	introducir	los	detalles	necesarios,	haga	clic	en	el	botón	(+)	para	crear	el	activo.

Para	eliminar	un	activo,	haga	clic	en	el	icono	de	papelera	en	cualquier	momento.

Puede añadir varios paneles de incendios y activos conectados.
Los	activos	de	panel	conectados	(p.	ej.,	detectores,	puntos	de	llamada	de	alarma)	deben	estar	vinculados	a	un	activo	de	panel.
Los	campos	«Location»	(Ubicación)	o	«Loop	&	Address»	(Bucle	y	dirección)	son	obligatorios	para	los	activos	de	panel	direccionable.
El	campo	de	ubicación	es	obligatorio	para	los	activos	que	no	son	de	panel	y	los	activos	de	panel	convencionales.
Para	que	la	identificación	sea	fácil,	describa	la	ubicación	de	forma	concisa	(preferiblemente	entre	2	y	3	palabras).

Figura 14



16 DT Connect

6.4 Carga de activos en CSV

«CSV	Asset	Upload»	(Carga	de	activos	en	CSV)	permite	a	los	usuarios	importar	listas	de	activos	por	lotes	desde	otro	software	u	hoja	
de	cálculo.	Con	esta	función,	los	usuarios	pueden	importar	datos	de	forma	eficiente	y	empezar	las	pruebas	sin	demoras.	

Sencillamente descargue la plantilla en CSV e introduzca los detalles de su activo en las columnas (Fig. 16). 

1. En	la	pestaña	«Assets	List»	(Lista	de	activos),	haga	clic	en	«Upload	Assets»	(Cargar	activos)	para	abrir	el	menú	«Select	Fire	
Panel» (Seleccionar panel de incendios) (Fig. 15). 

2. Seleccione un panel de incendios existente donde cargar los activos.
3. Seleccione «Create New Panel» (Crear nuevo panel) para cargar activos en un panel nuevo.
4. Haga clic en «Select Panel» (Seleccionar panel) para continuar.
5. Descargue la plantilla en CSV, complete los detalles del activo, vuelva a la página de carga del archivo CSV y haga clic en 

«Upload Asset CSV File» (Cargar archivo CSV de activos).

En	la	guía	de	la	plantilla	en	CSV	puede	consultar	más	información	útil	y	para	la	solución	de	problemas	si	el	proceso	de	carga	de	su	
archivo da error.

Figura 15 Figura 16
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7.1 Descripción de Job Reports (Informes de la tarea)

La	pestaña	«Job	Reports»	(Informes	de	la	tarea)	ofrece	una	descripción	de	las	tareas	completadas	en	la	aplicación	DT	Connect.	
Cada	fila	muestra	detalles	clave	de	la	tarea,	como	dirección	del	sitio,	fecha,	cliente,	técnico,	duración	de	la	tarea	y	dispositivo	
empleado.

Haga clic en «View» (Ver) para abrir el informe detallado de la tarea (Fig. 17).

Los	informes	pueden	buscarse	desde	la	barra	de	búsqueda	o	filtrarse	por	cliente,	fecha	o	técnico.

Figura 17

INFORMES
7
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7.2 Página Job Reports (Informes de la tarea)

Cada informe de tarea contiene un desglose detallado de todas las actividades de prueba realizadas durante la tarea.

En	«Test	Log»	(Registro	de	pruebas)	a	la	izquierda,	puede	ver	las	pruebas	capturadas	en	orden	cronológico.

«Job Summary» (Resumen de la tarea) a la derecha ofrece un resumen de los activos probados, las pruebas capturadas por XTR2 y 
el total de activos del sitio.

A	continuación,	una	tabla	enumera	los	tipos	de	activos	y	sus	resultados	correspondientes,	junto	con	un	capo	de	notas	de	la	tarea	y	
una	sección	de	firma	que	pueden	editarse.

• View Report (Ver informe): abra el informe en PDF de esta tarea.
• Share	Report	(Compartir	informe):	envíe	por	correo	electrónico	el	informe	en	PDF	a	los	destinatarios.
• Download CSV (Descargar CSV): exporte un archivo CSV con los resultados de la prueba.
• Delete	Report	(Eliminar	informe):	elimine	el	informe	de	forma	permanente.	Esta	acción	no	se	puede	deshacer.

Ejemplo	de	notas	de	la	tarea:	el	sistema	de	alarma	de	incendios	se	ha	inspeccionado,	sometido	a	pruebas	y	mantenimiento	de	
conformidad	con	los	requisitos	de	la	norma	BS	5839-1:2017.

Figura 18
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7.2.1 Informe en PDF 7.2.3 Assets Tested This Visit (Activos 
            probados en esta visita)

7.2.2 Job Summary (Resumen de la tarea)

El	informe	de	tarea	en	PDF	es	un	documento	profesional	que	
resume	la	tarea	que	ha	completado	para	el	cliente.

Se divide en tres secciones principales:

La página «Assets Tested This Visit» (Activos probados en esta 
visita) contiene un desglose completo de cada activo probado y 
los resultados de sus pruebas, con una fecha y marca de tiempo.

Si	los	resultados	arrojan	algún	error	o	no	es	posible	realizar	las	
pruebas,	aparecerán	en	la	parte	superior	para	que	el	cliente	
pueda verlos claramente.

Los	activos	que	se	verifican	correctamente	al	cotejarse	con	el	
registro de eventos del panel de incendios durante la tarea, 
se	identificarán	con	una	marca	de	verificación	en	la	columna	
«Panel Reconciled» (Panel reconciliado) (Fig. 20).

La página «Job Summary» (Resumen de la tarea) contiene 
detalles del sitio, un resumen de los activos probados y el 
número	de	pruebas	registradas.

A	continuación,	se	incluye	un	desglose	detallado	de	tipos	de	
activos y sus resultados correspondientes. De esta forma, el 
cliente tiene un resumen de la tarea fácil de entender, con notas 
y	una	firma.

Figura 19

Figura 20

NOTA: 
Las	filas	de	activos	y	resultados	solo	estarán	visibles	si	ese	
tipo de activo o resultado se captura.

NOTA: 
Si	no	prueba	ningún	activo	durante	la	prueba,	esta	página	
permanecerá oculta.
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7.2.4 Pruebas capturadas por XTR2

La	última	página	contiene	el	registro	de	pruebas	del	XTR2,	que	
ofrece	un	registro	cronológico	de	las	pruebas	capturadas	por	el	
XTR2.

Esta página ofrece una capa más de prueba y cumplimiento, 
para	dar	garantías	a	los	clientes	de	que	sus	activos	se	han	
probado correctamente.

Cada	fila	muestra	el	tipo	de	prueba	utilizada	por	el	XTR2,	los	
detalles	del	activo	correspondiente	(si	se	introdujeron)	y	el	
resultado capturado por el dispositivo.

Figura 21
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Figura 22

8.1	Configuración 8.2 Carga del logotipo de la empresa

8.3 ID de empresa

8.4 Detalles de la empresa

8.5	Detalles	del	perfil

8.6 Personalización del trabajo

8.7 Cambio de la contraseña

El	menú	«Settings»	(Configuración)	permite	a	los	usuarios	ver	y	
gestionar varios detalles y preferencias, como:

• Código	de	la	empresa
• Logotipo de la empresa
• Detalles de la empresa
• Personalización	del	trabajo
• Detalles	del	perfil
• Cambio de contraseña
• Información	de	contacto	del	servicio	de	asistencia

Para cargar el logotipo de una empresa, haga clic en «Upload 
Logo»	(Cargar	logo).	A	continuación,	seleccione	su	logotipo	
desde el explorador de archivos. 

Este logotipo se verá en el portal web y en la página de portada 
de	cualquier	informe	de	tarea	en	PDF.	

Haga en el icono de papelera para eliminar el logotipo de su 
empresa.

«Company	ID»	(Identificador	de	la	empresa)	es	un	identificador	
único	que	los	técnicos	usan	para	conectarse	a	la	aplicación	DT	
Connect	con	el	perfil	de	su	empresa.	

Una vez conectados, los técnicos pueden realizar pruebas y 
generar informes para los sitios almacenados en la cuenta de su 
empresa.

La	sección	«Company	Details»	(Detalles	de	la	empresa)	permite	
a	los	usuarios	editar	información	de	la	empresa,	como	el	
nombre,	la	dirección,	el	código	postal	y	el	país	de	la	empresa.	 

La	sección	«Profile	Details»	(Detalles	del	perfil)	permite	a	los	
usuarios	editar	la	información	de	sus	perfiles,	como	el	país	y	la	
dirección	de	correo	electrónico.	

Puede	activar	la	función	«Loop	&	Address	Required»	(Requerir	
bucle	y	dirección).	

Si	lo	hace,	la	aplicación	DT	Connect	pedirá	a	los	técnicos	que	
introduzcan	detalles	del	bucle	y	la	dirección	al	crear	un	activo	
conectado a un panel direccionable. 

De	este	modo,	se	garantiza	que	todos	los	activos	queden	
correctamente	identificados	usando	el	campo	«Loop	&	
Address»	(Bucle	y	dirección).

Para cambiar su contraseña, haga clic en «Change Password» 
(Cambiar contraseña), introduzca su contraseña actual, seguida 
de	su	contraseña	nueva	y,	a	continuación,	guarde	los	cambios	
haciendo clic en «Save Changes» (Guardar cambios).

CONFIGURACIÓN
8
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Dado	que	seguimos	una	política	de	mejora	constante,	 los	detalles	de	 los	productos	descritos	en	esta	publicación	están	sujetos	a	cambios	sin	
previo	aviso.	En	el	momento	de	entrega	a	la	imprenta,	se	considera	que	toda	la	información	proporcionada	aquí	es	correcta.	Se	han	hecho	todos	
los	esfuerzos	para	garantizar	la	exactitud	de	la	información,	que	se	facilita	de	buena	fe;	sin	embargo,	no	se	pretende	que	la	información	que	aquí	se	
menciona	constituya	un	compromiso	o	garantía,	ya	sea	expresa	o	implícita,	ni	que	establezca	las	bases	de	cualquier	tipo	de	relación	jurídica	entre	
las	partes	de	este	documento,	adicionales	a	o	en	lugar	de	estas	que	puedan	ser	aplicables	a	un	contrato	de	venta	o	compra.  LI
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